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Links New Access 2.0 Overview 

Links Access 2.0 is essentially a ‘snap-on’ or free floating external application that runs as 

Windows Service, independent to that of the Links application itself. It interacts with the 

database via a service that queries the database directly.  

These are Microsoft .Net applications therefore all machines that the applications will be 

installed on must have the latest .Net frameworks and service packs installed. 
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Links Access Services and Client Tools 

The Links Service consists of two main components;  

Links Access Service  

This is the service that queries the Links database. This service can reside on the database 

server or any other machine within the local network but this machine should always remain 

running. 

Links Access Client Service 

This is a ‘Floating’ service that coordinates Access Points and devices and passes requests to 

the Access Service. When dealing with solely IP scanning devices this service can be loaded 

on any machine in the local network but this machine should always remain running. 

Special Circumstances  

 In the event that a serial access device is directly connected to a machine, this 

machine will need to have the access client service installed for the access device to 

operate.  

 When using a multi-location database and access control, the access client service 

must be loaded locally on at least one machine per location. 

Links Access Client Tools 

There are also two auxiliary components to the Access Client Service, known as the Links 

Access Client Tools. 

Links Access Setup  

This is the main configuration software that is used to: 

 Define and Setup Access Points 

 Allocate Activities and Permissions to Memberships, Visit Passes, Services and Class 

Types 

 Configure access hardware such as controllers, IP and serial scanners 

Links Access Monitor 

 This toll provides the ability to see the access activity at each of the nominated access 

points at the facility. Information provided includes: 

 Displays the Customers photo 

 Displays Customers entry status 

 Displays Customers entry reason 

 Allows for remote opening of access points  
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Services Installation 

The software is delivered as three separate executable files. 

 

 

 

The Installation must happen in this order:  

1. Access Service  

2. Client Service  

3. Client Tools 

Installing Links Access Service 

1. Click Next to begin the installation of the Access Service. If the service is being 

installed on a Windows 7 based machine, right click the installer and choose the ‘Run 

as Administrator’  

 

 

 

 

 

 

 

 

2. Keep the default installation path 
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3. You will be prompted for initial connection settings during the installation. The Access 

Service is being installed and therefore the connection settings that are required are 

those for connection to the SQL database.  

 

4. Specify database connections in the same manner as when installing the Links client 

for the first time and test the database connection.  

5. Click the General tab and tick “enable logging”. Logging is an invaluable 

troubleshooting utility that can be utilised when devices such as RFID readers fail to 

‘come online’. 

 

6. Once connection is successful, click Ok and Finish.  This concludes the installation of 

the Access Service. 

  



 

Access 2 User Guide  August 2013  6 

Installing Links Access Client Service 

1. Click Next to begin the installation of the Access Client Service. If the service is being 

installed on a Windows 7 based machine, right click the installer and choose the ‘Run 

as Administrator’. 

 

2. Keep the default installation path 

 

3. You will be prompted for initial connection settings during the installation. The Access 

Client Service is being installed and therefore the connection settings that are 

required are those for connection to the floating service. In most cases the Access 

Service will be installed on the same machine as the Client Service and therefore the 

connection address required is simply ‘localhost’ or 127.0.0.1. 
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4. As above the service address will generally be the localhost, unless the Access 

Service has been installed on another machine, and therefore the service address 

would be that address. The access controller Id should in most cases remain as ‘1’. 

This value refers to which controller this machine will be, it could possibly be two and 

above if a more intricate setup were to be applied where multiple controllers were 

employed for each physical bank of Access Points. An example being a controller for 

gym turnstiles and a controller for health club gates. 

 

5. Click Save and Finish to complete the installation. 

Installing Links Access Client Tools 

1. Click Next to begin the installation of the Access Client Tools. If the service is being 

installed on a Windows 7 based machine, right click the installer and choose the ‘Run 

as Administrator’. 
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2. The options for installation include either the Links access monitor, access setup or 

both. If the client tools are being installed on the server then the access setup is only 

required as it is the component that administers and maintains all aspects of access, 

where as the monitor simply displays the data on the Access Point communication 

channels. 

 

3. If the tools are being installed on a POS machine then only the monitor would 

probably be installed. This would be used on occasions where POS has a secondary 

monitor to display visits. 

4. You will be prompted for initial connection settings during the installation.  The Access 

Monitor is being installed and therefore the connection settings that are required are 

those for the Links Access Service. This is where the monitor derives its data from.  

5. Click Next, test the settings, when settings are successful click finish to complete the 

installation. 
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Configuration of New Access 

The entire configuration of New Access 2.0 is carried out via the Access Setup Client tool. 

Careful planning is required in developing the schema of how access control will work in the 

designated facility. This is particularly relevant if the facility is to have multiple access points 

and access points with varying restrictions based on Membership, Visit Passes, Classes and 

Casual entry. 

It is important that the access configuration is discussed with a Links staff member before 

commencing or planning.  

Depending on the situation, in the case of a single entry access control point, the original 

access module may be better suited. 

Prerequisites 

The following prerequisites are required prior to setup: 

 A fixed IP address is required for each IP device or scanner 

 Activities created in the Links database. 

 Communication settings of any serial device (i.e. Comm. Port, baud rate, etc) 

 

1. From the Windows in the start menu, select the All Programs item, then the Links 

Modular Solutions menu.  

2. Under the Links Access Client Tools sub menu, select the Links Access Setup> Access 

Setup. 

3. A log in screen will be displayed. 

4. Only the staff nominated as Links Administrators will the ability to utilse this tool. 
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Profiles 

Profiles define what types of customers will be processed by the Access Controller and 

Access Points. A profile must be created before any further action can be taken. 

This screen can be opened from the Settings Menu> Maintain Profiles sub-menu.  

 

1. Press the New button to create a new profile 

2. Type in the profile  

3. Type a name for the description to differentiate between other profiles 

4. Specify general conditions for the service to check during an entry request 

Allow Staff 
An active staff member will be allowed entry through the 

access point. This will ignore any other validation. 

Check Accounts 
Will check if the customer has an outstanding customer 

invoice payment and stop entry. 

Check Laybys 
Will check if the customer has an outstanding layby payment 

and stop entry if it is due. 

Check Students 
Will check and validate customers who have current student 

bookings. 

Check Members 
Will check and validate customers who have membership 

contracts. 

Check VP 
Will check and validate customers who have visit pass 

contracts. 
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Adding a Controller 

The first step in creating the ‘Access Chain’ is to specify the ‘Controller’. This refers to the 

machine that has the Access Service installed. 

 

 

To create a controller setting, grab and drop the Controller icon from the right hand icons 

and place it on the Server icon.  

A connection line is now drawn between the Server icon and the Controller icon. The 

controller icon can be moved around the screen and the connection line will remain 

unbroken. 

 

Controller Configuration 

In the middle right hand section of the screen the controller settings screen is displayed. 

Enter the: 

 Controller description 

 IP address of the Server 

 A display (identity) name  
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Adding an Access Point 

The second step is to specify and create an Access Point to attach to the controller. Think of 

the Access Points as a visual representation of the actual access point points in the facility 

and name them accordingly. 

1. To attach an Access Point to a controller, click and highlight the newly created linked 

controller and then drag and drop an Access Point icon from the right hand side onto 

the controller icon  

2. A connection line is now drawn between the Controller icon and the icon. The 

Access Point icon can be moved around the screen and the connection line will 

remain unbroken. 

 

Access Point Configuration 

There are several options that can be selected which will define how the access point will 

operate once utilised. 

Centre Access 

This will perform a full and validation check of the customer of 

upon scanning. This will also create a visitation record against 

the membership or visit pass or student attendance. Generally 

used for entry through turnstiles / gates into a specific areas. 

Internal Access 

Used at secondary scan points. This will only allow entry if the 

customers has entered through a related valid centre access 

point. This will not create a visitation record but it will record a 

related activity attendance. 

Gender 
This setting will allow for access exclusion based on gender. 

Choose one of the options male, female or mixed mode. 

Profile 
Select the preferred profile as created in the first step of this 

configuration document. 

Save Visit Defines if the Access Point should record visit against customer. 

Settings 
Specify a description and name for Access Point. The Name 

specified will be used when recording attendances in Links. 
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1. Leave the box ticked for centre access or un-tick for internal access. 

2. Use the drop down arrow to select the gender type. 

3. Use the drop down arrow to select a profile. 

4. Untick the Save Visit box to disable attendance recording in Links 

Adding a Device 

There are several different devices and device variations that can be added to an access 

point. These include: 

 Serial Devices 

 

Use this device setting when there is no requirement to 

control/open access hardware i.e. turnstile or doors. This can 

be used for member self scan points at reception and in this 

scenario the scanner is directly connected to the reception 

computer. 

 

Use this device setting when utilizing a Links supplied, serial 

only, turnstile controller/relay trigger. These are used to 

control/open access hardware i.e. turnstile or doors. 

 

This is an old legacy device setting for clients who utilise a non 

Links controller/relay trigger. This device setting will send a 

relay pulse to the nominated serial port. 

IP Devices 

 

Use this device setting when utilising the Gantner brand of IP 

based access scanners. 

 

Use this device setting when utilizing a Links supplied, IP 

turnstile controller/relay trigger. These are used to 

control/open access hardware ie turnstile or doors. 
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Device Configuration 

This section provides the ability to specify and configure the access device. 

To attach a device to an Access Point, click and highlight the newly created linked Access 

Point and then drag and drop a Device icon from the right hand side onto the Access Point 

icon.  

A connection line is now drawn between the Access Point icon and the Device icon. The 

Device icon can be moved around the screen and the connection line will remain 

unbroken. 

 

1. Enter the Baud rate of the Serial Port    (generally 9600) 

2. Enter the Communication Port Number on the computer that the unit will use 

3. Enter the No of Data Bits (usually 8) 

4. Enter the No of Stop Bits (usually 1) 

5. Output State is used to set the actions of the trigger relay on a successful entry. 

 Off – no relay action 

 RTS Off – relay will activate on successful entry 

 RTS On –relay is on and deactivated on successful entry. 

 RTS Hold – The number entered will define the length of time (in seconds) that the 

relay signal is active or deactivated 

6. Enter Description and Name for device. 

7. RFID Prefix - Used if there is a need to remove data from an RFID id number.  

8. Select the serial type as defined previously 
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IP Devices 

A fixed IP address is required for each IP device being utilised. 

1. Enter the Description for the device 

2. Gantner State – This can’t be modified 

3. IP Address – Insert the IP address 

4. Port – Don’t modify the default number 

 

Links ETC 

1. Enter Description for the device 

2. IP Address – Insert the IP address 

3. Port – Don’t modify the default number 

4. Relay - Used to set the actions of the relay on a successful entry 

 Relay 1– Only this relay will activate on successful entry 

 Relay 2 – Only this relay will activate on successful entry 

 Both – Both relays will activate on successful entry 

 Both RTS On –Both relays are on and relays are deactivated on successful entry 

5. Relay Length - The number entered will define the length of time (in mille-seconds) 

that the relay signal is active or deactived. 
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Configuring Operational Parameters 

New Access 2.0 has been developed using many of the principles of security systems and the 

expectations of old access users. Whilst customers are fully validated on each scan, access 

points can now have defined time limits, grouped permissions and ease staff movement. 

Prerequisites 

Activities need to have been created in Links and these actives designated for use in new 

Access 2.0. 

Step1 - Assigning Activity & Availability Times to an Access Point 

From the main menu in the access setup application select Access Points menu and the 

Templates sub menu. 

It is possible to apply several activities to an access point but be aware that a customer 

can’t have multiple reasons to go through the access point.   

1. Access Point - Use the dropdown button to select an access point 

2. Activity - Use the dropdown button to select an activity 

3. Press the Add Row button and the following screen is displayed 

 

4. Use the drop down buttons to select a Day, From Time and To Time 

5. Tick the 24-Hour Box for 24hr access 

6. Click Save 

 

7. This window will now have availability for Monday.  Perform the above process for 

each day or press the Create Week button, and the entire week will be created with 

access times mimicking that of Monday. Each day can be manually edited, for 

reduced to resent the operating hours required.  
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Step 2 - Activities Assignment 

The next step in access configuration is to assign an activity(s) to Memberships, Visit Passes, 

Class Types, Services, or Guest Pass as required.  

This function can also be performed in the Links but not as a bulk process.  

From the main menu in the access setup application select Activities menu and the 

Permissions sub menu. 

1. Location – Use the dropdown button to select the location (if applicable) 

2. Type - Use the dropdown button to select from 

 Services 

 Memberships 

 Visit Passes 

 Class Types  

 Guest Passes 

3. Tick the box to apply an item against an access point 

4. Press the Save button once selection is completed 
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Global Activities – Reciprocal Rights 

In a multi-location database it is possible to allow customers to utilize their membership, visit 

pass or student status, at another location(s), commonly known as reciprocal rights. This 

function is performed by the use of Global Activities which are also created in Links.  

Global activities will also display in this screen and it is up to the host location to identify the 

membership, visit pass or student status that they wish to identify as having reciprocal rights.  

Step 3 New Access Parameters 

The following screen provides the opportunity to add further functionality to the access 

program and includes the ability to cater for casual entry  

This screen can also be found in the Links program but the Links version has one additional 

setting and a section that displays New Access Points names. 

From the main menu in the Access setup application select the Settings menu and the 

Global Settings sub menu. 

 

New Access 

Module 
This flag is used to set Access 2.0 at a site level. 

Service Entry at 

Turnstile 
Activates the casual receipts process in Links. 
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Access For 

Customer Cards 

Will display a specialised screen at reception when 

purchasing a casual service. This screen can be used to enter 

a card number and the card can then be used to enter 

through an access point. 

Access For Casual 

Sales 

Will allow the validation of a barcode at an access point that 

is produced when a casual service is purchased. 

Service Must Be 

Used Within 

Specifies the amount of time allowed before a barcode 

generated from the sale of a service must be used before it 

will expire. 

A visit will allow 

entry for 

Specifies the amount of time before a new visit will be 

registered at an access point against a Membership. 

Minutes prior to 

class allowed 

Specifies the amount of time before a class commences that 

a student is able to gain entry through an Access Point. 

Minutes after class 

allowed 

Specifies the amount of time after a class commences that a 

student is able to gain entry through an Access Point. 

Permit Entry 

Outside of Class 

Times – Perpetual 

Students 

Allows unconditional access for students but they must have 

a current booking and are booked in as reoccurring 

(perpetual) Students. 

Permit Entry 

Outside of Class 

Times – Term 

Students 

Allows unconditional access for Students but they must have 

a current booking and booked in for a fixed number of 

weeks. 

Include Future 

Account in 

Balance  

 

Access validation will look for any outstanding future class fee 

balances and prevent entry if there is an outstanding 

balance.  

Messages at 

Devices 

Insert the message that will be displayed for Device OK 

(successful validation), No Entry (unsuccessful validation) and 

Go to Reception. These are only relevant if using Gantner 

devices. 
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Restarting the Access Service and Access Client Service: 

Once all initial configurations have been completed, the services should be restarted. This 

process is completed through the ‘Services’ menu in the Control Panel. This can be found via 

“START > Control Panel > Administrative Tools > Services”.  

Scroll down the list to “LinksService” and ‘LinksAccessClientService’. 

The services can be started by right clicking and stopping the service and then right clicking 

and starting them again.  

The Client Service must be stopped first followed by the Access Service. The Access Service 

must then be started first followed by the Client Service.  

 

Access Monitor 

The Access Monitor provides a visual identification of the customer utilising the Access Point. 

Identification is by: 

 Photo of the customer 

 Background colour – Green for ‘allowed entry’ or Red for ‘rejected entry’ 

 Customers name and membership or visit pass description 

 Reason for rejected entry 

The monitor also has the ability to manually activate the access point relay (if applicable), to 

open a door or release a turnstile remotely. 

From the start menu click on ‘Links Modular Solutions > Links Client Tools > Access Monitor’ 

and log in with a staff code. 

 

There a number of sub menus under the File menu that allows for user modification. 

Clear Layout Items Clears the monitor layout settings 
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Save Layout Saves the monitor layout settings 

Simulate Entry 

This screen is used to identify if there is a database 

connection. Enter a customer number and it should return 

display the customer’s name on the monitor screen if the 

connection is valid. Please note that this method doesn’t 

perform a validation of the Customer’s status. 

Settings 

1. Tick the box to display messages 

2. Tick for a sound to play when an access visitation occurs (not functional as at July 

2013) 

3. Set the number of seconds for the visitation response to be cleared  

 

Monitor Display 
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Access Points 

Listed on the right hand side of the monitor. The rectangle 

displays the access point name, a Manual Open button and 

access visitation response. 

Grid Layout 
Set the grid layout rows and columns to suit the number of 

access point windows to be displayed. Maximum of 10 X10 

Access Window 

Drag and drop an access point name into the access 

window on the grid. The access point name will now be 

inserted into the designated window. 

The Manual Open button is displayed in the top left hand side 

of the window 

The connection status of the access point is displayed in the 

top right hand side of the window. 

The background colour represents Green for ‘allowed entry’ 

or Red for ‘rejected entry’. 

Customer photo is displayed. A silhouette is shown if the 

customer doesn’t have a photo attached to their customer 

record. 

The access response is displayed in the bottom left hand side 

of the window. It is also duplicated in the access point 

button. 

It is possible to view previous visit history records for the access 

point by right mouse clicking on the window. A Show History 

Menu is presented. Select this menu item to display the 

following screen  
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Trouble Shooting Guide 

The following is a basic troubleshooting guide to assess the reasons a customer may have 

‘Access Denied’ when attempting to use centre Access Points.  

Error Messages 

Could Not Find a 

Valid Reason for 

Visit (No reason 

found for 

entrance) 

There are several reason why this message is displayed 

 The card is not allocated to a person 

 There is no current membership or visit pass contract or 

class booking attached to customer 

 The customer could also have a ‘future’ contract but 

access will be denied until the contract commences  

 Student may be early for the class booking 

Entry Point Not A 

Centre Access 

Point 

Customer has bypassed a designated centre access point and is 

trying to enter an internal access point. 

Entry Is Not 

Permitted at this 

Location 

Customer is attempting to use an access point that their contract 

does not allow. 

Unknown Card or 

Person 00XX0XX0 

Customer has a card, band or fob that has not been allocated to 

them. 

The Customer Has 

Amount $xx.xx 
Customer currently owes money against their contract. 

Double Swipe 

Within xx Seconds 

Customer has swiped their card, band or fob at multiple access 

points within a defined time period. This parameter can be edited 

in Admin Module> Site> New Access Parameters.   

Visit Pass Has No 

Remaining Visits 
Customer has used all available visits on current Visit Pass. 

Member Visit Out 

of hours 

Customer has an off peak membership and is attempting to visit 

outside defined off times. 

Bad Read 
Customer is attempting to scan the card, band or fob cannot be 

read by a scanner. 

Owes Money For 

Classes 
Student has an outstanding balance. 
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Links Configuration 

By default, the New Access module is not activated in Links as part of a standard installation. 

Once purchased, the module can be activated by a Links staff member. 

Once activated, an additional menu item will appear under the site menu in Administration 

Module. (The module must be restarted in order for this to take effect)  

To see if the module is activated, go to Admin> Site> New Access Parameters. 

Activities 

New Access 2.0 utilises Activities as a method of determining whether a Membership type, 

Visit Pass, Class Type or Service is allowed to proceed through an Access Point or points. As a 

result the Activities Screen includes the ability select an activity for use in access control as 

well as being traditionally used in the “Activity Survey” process. Through this combination, 

activity usage will be automatically recorded as part of the customer’s movement through 

Access Points.  

With sites that have minimal Access Points, the number of activities are considerably 

reduced. For example, small sites such as a 24-hour gym with only a single Access Point and 

limited number of Membership types, a single activity is required.  

Those sites with multiple Access Points, Membership types and access times will require 

additional activities to cater for pool only entry or gym only entry or combinations. 

Creating Activities 

The Activities screen can be found in Admin> Memberships/VP> Activities. 
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Code 
Type in a unique code which will to be used to identify the activity 

and for referencing in setting up Access Point permissions. 

Description 
User reference for the activity. This cannot be seen within the 

Access Service setup. 

Access 
This flag will nominate that the activity can be used for access 

entry.  

Global 
This will indicate that the activity will allow access at other 

participating locations. 

Applying Activities 

Activities are applied to Membership, Visit Passes, Services and Class Types, by use of the 

activity tab attached to each respective setup screen in administration module. 

The example below shows the membership setup. 

 

Note that it can have multiple Activities for both access and activity survey reason needs. 

Available Activities displays Activities assigned to the Membership. 

To add a new Activity use the drop down arrow on the right hand side of the screen and a 

drop down list will display Activities. 

Use the ‘Setup Activities’ button to create new Activities. 

Activities can be added or removed through both the above method or in bulk by utilising 

the Activity Assignment function in the Access Setup. 
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The Class type activity can be added under the ‘Public Holiday’ Tab in the Class Types setup 

screen of the Class Menu in the Admin module.  

 

New Access Parameters 

Admin> Site> New Access Parameters 

This screen is a duplicate but has one additional setting and a section that displays new 

Access Points names. 
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New Access 

Module 
This flag is used to set Access 2.0 at a location level 

Service Entry at 

Turnstile 
Activates the casual receipts process in Links. 

Access For 

Customer Cards: 

Will display a specialised screen at reception when purchasing a 

casual service. This screen can be used to enter a card number 

and the card can then be used to enter through an Access Point. 

Access For Casual 

Sales 

Will allow the validation of a barcode at an Access Point that is 

produced when a casual service is purchased. 

Service Must Be 

Used Within 

Specifies the amount of time allowed before a barcode 

generated from the sale of a service must be used before it will 

expire. 

Minimum Double 

Swipe 

Specifies the amount of time (seconds) before a customer card 

can be re-presented at the same Access Point before accepting 

another visit registration. 

A visit will allow 

entry for 

Specifies the amount of time (minutes) before a new visit will be 

registered at an access point against a membership. 

A VP visit will allow 

entry for 

Specifies the amount of time (minutes) before an additional visit 

will be removed from a visit pass after registering at an Access 

Point. 

Minutes prior to 

class allowed 

Specifies the amount of time (minutes) before a class commences 

that a student is able to gain entry through an Access Point. 

Minutes after class 

allowed 

Specifies the amount of time (minutes) after a class commences 

that a student is able to gain entry through an Access Point. 

Permit Entry 

Outside of Class 

Times – Perpetual 

Students 

Allows unconditional access for students but they must have a 

current booking and are booked in as reoccurring (perpetual) 

students. 

Permit Entry 

Outside of Class 

Times – Term 

Students 

Allows unconditional access for students but they must have a 

current booking and booked in for a fixed number of weeks. 
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Include Future 

Account in 

Balance  

Access validation will look for any outstanding future class fee 

balances and prevent entry if there is an outstanding balance.  

Messages at 

Devices 

Insert the message that will be displayed for Device OK (successful 

validation), No Entry (unsuccessful validation) and Go to 

Reception. These are only relevant if using Gantner devices. 

Access Points 
Displays the Access Points that have been created in the New 

Access Client Tools. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


